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1 Description

The Type 3730-3 Positioner in ESD version
is based on the Type 3730-3 Positioner with
HART® Communication.
These mounting and operating instructions,
EB 8388-1 EN, supplement EB 8384-3 EN
and focus on the ESD functions.

Technical data, attachment, electrical and
pneumatic connections as well as operation
and the standard EXPERT valve diagnostics
are dealt with in Mounting and Operating
Instructions EB 8384-3 EN.

Note!
The optional external position sensor cannot
be used with the Type 3730-3 Positioner in
ESD version.

Extended EXPERT+ valve diagnostics are de-
scribed in EB 8388 EN. By default, all
positioners in ESD version include the
EXPERT+ valve diagnostic functions.

Note!
Positioners delivered not mounted on an ac-
tuator are configured with the default set-
tings, which means that the ESD functions
are not activated.
After mounting the positioner on a safety
shut-off valve and starting it up, switch the
positioner to ESD mode to allow it to per-
form the safety functions (for required set-
tings and instructions, see section 2 and
EB 8384-3 EN).

1.1 General

Note!
When the ESD function is active, the
positioner keeps the attached valve to a set
position, e.g. open. The valve does not per-
form any control tasks anymore.
In AUTO operating mode, the positioner
can be used to control the attached valve.

ESD (Emergency ShutDown) is a positioner
function with extended firmware and partial
stroke testing for the predictive, status-ori-
ented detection of malfunctions in pneumatic
shut-off valves in safety instrumented systems
(SIS).

As a result, the probability of failure on de-
mand (PFD) can be reduced and mainte-
nance intervals can be extended.

All testing and diagnostic functions are com-
pletely integrated into the positioner. The
measured data and test results are collected
and stored in the positioner.
Partial stroke tests can be started and can-
celled either manually at any time (on site or
using an engineering tool) or automatically
according to a certain schedule.

A test status is determined at the end of a
partial stroke test, which allows operators to
directly see whether the test has been com-
pleted successfully or not. When the test has
not been completed successfully, possible
causes of the fault are given. Apart from be-
ing indicated on the positioner’s display or
in the engineering tool used, the test status is
also issued at the fault alarm output.
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Operation

The positioner can be operated on site using
the rotary pushbutton (see section 2.1.1
“On-site operation“). Alarms are indicated
on the LCD and issued over the fault alarm
output (condensed status).

The TROVIS-VIEW 3 software allows for
convenient operation when communicating
through the SAMSON SSP interface proto-
col. Thanks to DD and the FDT/DTM con-
cept, the ESD functions can easily be inte-
grated into the process control system or as-
set management system.

The instructions concerning operation in the
following sections refer to operation with
TROVIS-VIEW 3.

Note! All parameter settings entered in the
user interface need to be downloaded to the
positioner to become effective.

1.2 ESD functions

ESD mode

In ESD mode, the safety shut-off valve is
moved to a specific set point within its work-
ing range. The valve does not perform any
control tasks anymore. The valve is fully
closed in case of an emergency.

In its basic setting, the positioner behaves
similar to a solenoid valve, which keeps the
attached valve to a set position, e.g. open.

For test purposes, the partial stroke test can
either be started manually (ESD Man) or
triggered automatically according to sched-
ule (ESD Auto).

Partial stroke test

The partial stroke test integrated into the
positioner can prevent a normally open
valve or a valve in its end position from
seizing up or getting jammed.

As the course of the partial stroke test is
plotted, the dynamic control response can
also be analyzed.

During the test, the valve is moved out of the
end position or from a start value either in
steps or in a ramp function until it reaches a
defined final value. Then, the valve is moved
back again to its initial position.

The partial stroke test is performed, for ex-
ample between 10 and 15 % of the rated
travel, starting from the end position while
the plant is running, yet without disrupting
plant operation. The start and stop values
for the partial stroke test can be configured
by the user.

The following test cancellation conditions
provide additional protection against the
valve slamming shut and moving past the fi-
nal value:

� Valve position x
� Drive signal y
� Maximum test time is exceeded
� Tolerance range exceeded

The course of the controlled variable x, ref-
erence variable w, setpoint deviation e, and
drive signal y parameters is saved in the
positioner, assigned to the operating hours
counter.

The dead time, T63, T98, overshooting, rise
time, and response time parameters of a
step response test are analyzed separately
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for the increasing and decreasing character-
istic.

The analyses of the last three partial stroke
tests are saved in the positioner with the as-
sociated time stamp.

The EXPERT+ test functions Data logger and
Hysteresis test to detect friction changes are
also available in ESD mode (see section 3
and EB 8388 EN).

Note!
The valve position is used as the valve travel
condition by the data logger of positioners
in ESD version.

1.3 Presetting the positioner

1.3.1 Converting TROVIS-VIEW 3

The TROVIS-VIEW 3 version must match the
software version of the positioner.

When establishing communication or ex-
changing data between the PC and the
positioner, the firmware version is checked
automatically and the appropriate
TROVIS-VIEW 3 module is loaded.

To adapt the TROVIS-VIEW 3 version before
transmitting data proceed as follows:

1. In the File menu, select Convert.
A window listing all available firmware
versions is opened.

2. Select “Version 1.xx-1.xx ESD”.

3. Confirm selection with OK.
TROVIS-VIEW 3 switches to the user in-
terface for the positioner in ESD version.
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1.3.2 Unlocking the positioner

To prevent unauthorized access, the
positioner settings cannot be changed unless
the valid ESD code has been entered.
The positioner needs to be unlocked sepa-
rately for on-site operation and operation
through TROVIS-VIEW depending on the
operating mode.

The ESD code can be found on page 21.
Remove the code or make it unreadable to
prevent unauthorized use.

Entering the code on the positioner

Default: OFF

Turn →Code 3

Press .

Turn →ON

Press .  Display shows: 0

Turn →ESD code

Press .  Display shows: ON,

Entering the code in TROVIS-VIEW 3

1. In the Device menu, select ESD enabling
code.
TROVIS-VIEW 3 establishes a connec-
tion with the positioner.

2. Enter the code in the Value field.

3. Confirm selection with OK.
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1.3.3 Printing the diagnostic/ESD
log

The Print command allows you to print out a
diagnostic log of individual tests or the en-
tire diagnosis.

The diagnostic log includes a title page and
a list of all the data points including all  their
values and properties.

The title page contains all key information
for clear identification of the printed log (de-
vice type, file name, time and date of cre-
ation, time and date of the last change and
TROVIS-VIEW version).

Select Print in the File menu to add further
information.

1. In the File menu, select Print Options to
choose the scope of the diagnostic log.

After installing/updating the
TROVIS-VIEW software, customer data
(Customer data in the Edit menu) and
summary (table of contents) are listed in
the diagnostic log by default.
Check the check boxes for the Comments
and Graphics options to add these op-
tions to the diagnostic log.

2. Right-click the [Diagnosis] folder or the
required subfolder and select Print from

the context-sensitive menu to print the di-
agnostic log.
The printout contains the contents of the
folder and its subfolders.

EB 8388-1 EN 7
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2 ESD functions

TROVIS-VIEW 3: [Diagnosis > Emergency
Shut Down]

In TROVIS-VIEW 3, the functions of the
positioner in ESD mode are listed in the
[Diagnosis] folder under Emergency Shut
Down. They include:

� Activating/deactivating ESD mode and
starting the partial stroke test

� Setting the parameters for partial stroke
testing

� Defining the cancellation conditions for
partial stroke testing

Note!
Instructions on how to change parameters
and start the partial stroke test can be found
in section 2.1 “Changing ESD parameters
and starting the partial stroke test“.

ESD mode

ESD mode is active if the Target mode pa-
rameter in the [Positioner] folder under Op-
erating mode is set to “Emergency Shut
Down“ and Desired ESD mode parameter in
the [Diagnosis] folder under Emergency Shut
Down is set to “On“.

In ESD mode, the safety shut-off valve is
specifically moved to the set point of the
valve working range (parameter: Required
manual reference variable w).

The positioner behaves similar to a solenoid
valve, which keeps the attached valve to a
set position, e.g. open. The valve does not
perform any control tasks anymore.

The current valve position is indicated under
Manual reference variable w.

The ESD operating mode parameter sets the
conditions for starting the partial stroke test:

Test started manually (ESD Man)
ESD operating mode parameter = ESD Man

Partial stroke testing begins when triggered
by the Start step response parameter. Other-
wise, the valve remains in the position de-
fined by the Required manual reference
variable w parameter.
Changes to the parameters can only be
made in ESD Man mode.

8 EB 8388-1 EN
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Test started automatically according to
schedule (ESD Auto)
ESD operating mode parameter = “ESD
Auto“

Partial stroke tests are conducted at regular
intervals. The Time until the next automatic
ESD test parameter indicates when the next
test is scheduled (countdown).

Partial stroke test

The course of the partial stroke test depends
on the parameters listed under Settings in
TROVIS-VIEW 3. Depending on the param-
eter settings, the partial stroke test is con-
ducted either in steps or in a ramp function
of the valve position (see Fig. 2).

After being triggered, the test does not start
until the Settling time before test start (t1) has
elapsed. This waiting period ensures that the
valve has reached the position defined by
the Step start parameter (pos. 2, see Fig. 2)
before the test starts.

Starting from the Step start position (pos. 2),
the valve moves to the defined end position
(Step end parameter, pos. 3). The valve re-
mains in this position for the time defined by
the Delay time after step (t2) before perform-
ing a second step change in the opposite di-
rection from Step end (pos. 3) to Step start
(pos. 2).

After the Delay time after step (t2) has
elapsed, the valve is moved back to its initial
position (= Required manual reference vari-
able w, pos. 1)

The Step tolerance limit (range: 0.1 to
10.0 %) sets the permissible tolerance limit
for the step’s start and end values.

The Scan rate (range: 0.2 to 30.0 s) defines
the interval at which the measured values
are recorded during the test. The positioner
stores a maximum of 100 measured values
per measured variable (valve position x, ref-
erence variable w, setpoint deviation e,
drive signal y and the time when they were
recorded). After 100 measured values per

EB 8388-1 EN 9

ESD functions



measured variable have been stored, the
logging is stopped. However, the test is still
completed. The Measured data storage out
of memory alarm is generated. The Recom-
mended sampling time, which should not be
shorter, if at all possible, is calculated from
the Duration of the test.

The Display section in TROVIS-VIEW 3
shows the Progress flag in percent.

1. Step response function, Fig. 2 left
The step response function is activated when
the Activation of the ramp function parame-
ter is set to "Off".
The valve is moved in steps to the Step end
position (pos. 3) during the first half of the
test and to the Step start position (pos. 2)
during the second half of the test.

2. Ramp function, Fig. 2 right
The ramp function is active when the Activa-
tion of the ramp function parameter is set to
"On".

Note!
A step before the partial stroke test can be
prevented by allocating the value of the
manual reference variable w to the Step
start parameter.

The valve is moved to the Step end (pos. 3)
and Step start (pos. 2) positions with fixed
velocities (v1 and v2) set by the Ramp time
(falling) and Ramp time (rising) parameters.

10 EB 8388-1 EN

ESD functions

Pos. 1

Pos. 2

Pos. 3

t1
t2

t2

[%]

[s]

Pos. 1

Pos. 2

Pos. 3

t1
t2

t2

[%]w w

[s]

t t

v1 v2

Fig. 2 · Courses of the partial stroke tests with step response (left) and ramp function (right)

Valve positions:
Pos. 1 = Required manual

reference variable w
Pos. 2 = Step start
Pos. 3 = Step end

Times:
t1 = Settling time before test start
t2 = Delay time after step

Velocities:

v1 =
100

Ramp time (falling)
%
s

v2 =
100

Ramp time (rising)
%
s

Step response Ramp function



The ramp time specifies the time required by
the valve to move through the travel range
100 to 0 % (falling) and 0 to 100 % (rising).

Note!
Times for the Ramp time (falling/rising) are
determined during initialization of the
positioner. These times are not to be ex-
ceeded when setting the parameters for the
partial stroke test with ramp function.

Cancellation conditions

To ensure that the running process is not dis-
rupted and that the shut-off valve does not
slam shut unintentionally, it is advisable to
define conditions that cause the positioner to
cancel an active partial stroke test. The
positioner issues an alarm when a test has
been cancelled (see section 2.2).
Possible cancellation conditions are:

� Max. test duration: The test is cancelled
when the maximum permissible test du-
ration (range: 30.0 to 3000.0 s) is ex-
ceeded.

� x control value: The test is cancelled
when the value falls below the adjusted
valve position (range: –10 to 110 %).

The condition is only active when Activa-
tion x control is set to “On“.

� y control value: The test is cancelled
when the value falls below the adjusted
drive signal (range: 0 to 9999 1/s).
The condition is only active when Activa-
tion y control is set to “On“.
Monitoring the drive signal y only makes
sense when the partial stroke test is per-
formed as a ramp function because the
y cancellation condition is always met
with the step response function.
A suitable y control value can be deter-
mined using the last performed partial
stroke test. After the test is completed, the
lowest drive signal value recorded by the
test is displayed under the Minimum
value y control (in TROVIS-VIEW 3 un-
der Display). This value should be used
as a reference value with a 15 % toler-
ance: y control value ≈ 0.85 x Minimum
value y control.

� ESD tolerance band: The test is cancelled
when the deviation of the valve position
(in relation to the step height) exceeds
the adjusted value (range: 0.1 to
100.0 %).

EB 8388-1 EN 11
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The condition is only active when Activa-
tion tolerance band control is set to
"On".

During the course of the test, the following
parameters are changed as specified:

� Lower x-range value (Code 8): 0 %
� Upper x-range value (Code 9): 100 %
� w-ramp OPEN/CLOSED (Codes 21/22):

variable
The data can be reset in the [Status mes-
sages] folder under Reset.

2.1 Changing ESD parameters
and starting the partial
stroke test

To change ESD parameters using
TROVIS-VIEW 3, proceed as follows:

1. Enter ESD code (see section 1.3.2).
If the positioner is not operated and no
data are modified by an operating
program (DTM or TROVIS-VIEW 3) for
15 minutes, the positioner is locked
again. To make additional changes, the
ESD code needs to be entered again.

2. In the [Positioner] folder under Oper-
ating mode, set the Target mode param-
eter to “Emergency Shut Down“.

3. In the [Emergency Shut Down] folder, set
the ESD operating mode parameter to
“On“.

4. In the [Emergency Shut Down] folder, se-
lect the ESD operating mode parameter
to “ESD Man“.
The positioner alternately displays
“ESd”, the Manual reference variable w,
and “MAN“.

5. Set the parameters in the [Emergency
Shut Down] folder as desired.

The further course of action depends on
whether the test is to be started manually
(–> Test started manually) or performed au-
tomatically at certain intervals according to
schedule (–> Test started automatically ac-
cording to schedule).

Test started manually

6. Right-click the Start step response pa-
rameter and select Execute from the con-
text-sensitive menu.

7. The test will start after the “Warning.
During test start the control valve departs
from its current position at full travel! Ex-
ecute test?“ message has been con-
firmed.
The positioner displays “tEst d4“.

Test started automatically according to
schedule

6. Set the Auto test time parameter to the
desired interval at which the partial
stroke test is to be repeated.
If Auto test time is set to “0”, the test is
not performed.

7. In ESD operating mode, select “ESD
Auto“.
The test is performed at the Auto test
time interval. The first test is started
when the interval has elapsed for the
first time.
After switching the operating mode and
returning to ESD Auto mode, the Auto
test time interval starts again.
The Time until the next automatic ESD
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test parameter indicates the time that re-
mains until the next test is started.
The positioner alternately displays
“ESd”, the Manual reference variable w,
and “MAN“.

At the end of the test, the Status of ESD test
indicates whether the partial stroke test has
been completed successfully or not (see sec-
tion 2.2 “Analyzing measured data“).

2.1.1 On-site operation

Note!
Parameters can only be changed in
positioners in ESD version after entering the
enabling ESD code (Code 3). You can only
change the reading direction (Code 2) if the
ESD code has not been entered.

The described settings can be adjusted di-
rectly on the positioner on site:

� Entering the ESD code using Code 3
� Selecting the ESD Man/ESD Auto oper-

ating mode using Code 0
The following modifications can only be per-
formed when the positioner is in ESD Man
operating mode:

� Setting the reference variable Manual w
using Code 1

� Setting the ESD parameters using
Code 49 (see section 2.5)

Starting the partial stroke test:

1. Select operating mode ESD using
Code 0.

2. In operating mode ESD, select ESD Man
mode, holding down the rotary
pushbutton until the countdown has
elapsed. The test will start.

Note! Section 2.5 lists the available ESD pa-
rameters.

2.2 Analyzing measured data

TROVIS-VIEW 3: [Diagnosis > Emergency
Shut Down > Analysis of measured data]

Analyses of the last three partial stroke tests
completed are saved in the positioner with a
time stamp.

If the test has not been completed success-
fully, the reason why the test was cancelled
is indicated under “Maintenance alarm“.
The positioner indicates “ESd tEst FAIL“. Pos-
sible reasons for cancellation depending on
the defined cancellation conditions are:

� x cancellation: The valve position fell be-
low the x control value.

EB 8388-1 EN 13
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� y cancellation: The drive signal fell below
the y control value.

� Tolerance band exceeded: The deviation
of the valve position exceeded the ESD
tolerance band.

� Max. test time exceeded: The test was
not completed within the specified period
of time.

Further error messages include:

� Test manually cancelled: The test has
been manually cancelled.

� Measured data storage out of memory:
The scan rate has been selected too low.
After 100 measured data per measured
variable have been recorded, the log-
ging stops. However, the test is contin-
ued.

� Aborted by solenoid valve: The test was
cancelled by the solenoid valve being
triggered.

� Supply pressure/friction: An insufficient
supply pressure or excessive friction oc-
curred during the test.

When a partial stroke test has been com-
pleted successfully, analyzed parameters
are displayed separately for the increasing
and the decreasing characteristic:

� Overshoot (relative to step change, [%])
� Dead time [s]
� T63 [s]
� T98 [s]
� Rise time [s]
� Settling time [s]

2.2.1 Condensed state/Fault alarm
output

The Fault alarm output parameter allows
you to define which type of alarm is issued
by the hardware fault alarm output (normal
error message and/or ESD status).

� Normal error message:
EXPERT/EXPERT+ condensed state (see
EB 8384-3 EN, Code 32 and 33)

� ESD status: ESD function status
� Normal error message and ESD status:

ESD function status plus EXPERT/
EXPERT+ condensed state

If a set ESD status (partial stroke test not suc-
cessful) is to be included in the condensed
state, go to the [Positioner] folder under [Er-
ror control > Classification report > Ex-
tended > Emergency Shut Down] and assign
a classification. The following classifications
(also see section 6.3 in EB 8384-3 EN, and
section 4 in EB 8388 EN) are available:

� Maintenance alarm
� Maintenance required
� Maintenance demanded
� No message [default]

When the default value “No message” is
set, the ESD status is not included in the con-
densed state.

Note!
The Fault alarm output parameter must be
set to “ESD status” or “Normal error mes-
sage and ESD status” to allow the ESD sta-
tus to be indicated at the fault alarm output.



2.3 Measured data

TROVIS-VIEW 3: [Diagnosis > Emergency
Shut Down > Measured data]

The following parameters are measured dur-
ing the partial stroke test:

� Valve position x
� Reference variable w
� Setpoint deviation e
� Drive signal y
� Time

These parameters are saved in a FIFO mem-
ory with a capacity of 100 measured values.
The last 100 measured values of the parame-
ters determined during the partial stroke test
are listed in the [Measured data] folder.

2.4 Resetting ESD

TROVIS-VIEW 3: [Diagnosis > Emergency
Shut Down > Reset ESD]

Using the Reset ESD parameter, the param-
eters of the ESD functions and the data log-
ger are reset to their default values.
Any recorded measured values, error
messages, and data logger data are de-
leted.

Note! After resetting the parameter, the
positioner is in the MAN operating mode.
The ESD mode needs to be reactivated.

EB 8388-1 EN 15
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2.5 List of ESD parameters

The ESD parameters can be found in the positioner under Code 49.
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Code
No.

Parameters – display,
Values [default settings] Description

Note! The positioner settings cannot be changed unless the ESD code has been entered under
Code 3, see section 1.3.2.
Modifications in Codes 1 and 49 can only be made when the positioner is in ESD Man
operating mode.

0 Operating mode
MAN – AUtO – SAFE – ESd (–> ESd
Man/ESd Auto) – ESC, [MAN]

AUtO: Automatic operation
MAN: Manual operation
SAFE: Fail-safe position
ESd Man: Manual ESD mode

Starting the partial stroke test manually,
see section 2.1.1

ESd Auto: Automatic ESD mode

1 Manual w
0 to 100 [0] % of the nominal range

Adjust the manual set point with the rotary pushbutton.
The current travel/angle is displayed in % when the
positioner is initialized. Otherwise the sensor position in
relation to the central axis is indicated in degrees °.

3 Unlocking the positioner,
configuration
OFF – ON – ESC, [OFF]

The positioner settings cannot be changed on site unless
the ESD code has been entered.

49 ESD parameters

d0 Time until the next automatic
ESD test
Display only.

Time remaining until the next ESD test is started.

d1 Auto test time
1 to 56280 h,  [1 h]

Desired time for repeating an ESD test

d2 Step start
0.0 to 100.0 %, [95.0 %]

Start value for step response

d3 Step end
0.0 to 100.0 %, [90.0 %]

End value for step response

d4 Activation of the ramp function
On – Off, [Off]

Activates or deactivates the ramp function.

d5 Ramp time (rising)
0 to 1000 s, [value determined
during initialization, minimum
value: 15 s]

Ramp time for 0 to 100 % (rising) of the ramp function.
A suitable value is determined during initialization; if
possible, make sure the ramp time does not fall below
this value.
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Code
No.

Parameters – display,
Values [default settings] Description

49 d6 Ramp time (falling)
0 to 1000 s, [value determined
during initialization, minimum
value: 15 s]

Ramp time for 100 to 0 % (falling) of the ramp function.
A suitable value is determined during initialization; if
possible, make sure the ramp time does not fall below
this value.

d7 Settling time before test start
1 to 240 s, [10 s]

Delay time before test is started to ensure that the valve
can be moved to the step start position safely (t1, Fig. 2)

d8 Delay time after step
1.0 to 240.0 s, [2.0 s]

Delay time between the first and the second step change
(t2, Fig. 2)

d9 Scan rate
0.2 to 30.0 s, [0.2 s]

Scan rate of step response measurement

E0 Activation x control
On – Off, [Off]

Activates or deactivates x monitoring

E1 x control value
–10.0 to 110.0 %, [0.0 %]

The test is cancelled when the valve position falls below
this value.

E2 Activation y control
On – Off, [Off]

Activates or deactivates y monitoring
Activation only makes sense when the partial stroke test
is performed as a ramp function.

E3 y control value
0 to 9999 1/s, [0 1/s]

The test is cancelled when the drive signal falls below
this value.

E4 Minimum value y control
Display only.

Indicates the smallest value that y assumed during the
last ESD test
This parameter can be used to determine the limit value
for y monitoring (y control value).

E5 Activation tolerance band
control
On – Off, [Off]

Activates or deactivates ESD tolerance band monitoring

E6 ESD tolerance band
0.1 to 100.0 %, [5.0 %]

The test is cancelled when the deviation of the valve po-
sition exceeds this percentage.

E7 Max. test duration
30.0 to 3000.0 s, [120.0 s]

Maximum test duration; the test is cancelled in any case
when this period has elapsed.

E8 – unassigned –

E9 Reset ESD All ESD parameters are reset to their default values. All
measured data are deleted.
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Code
No.

Parameters – display,
Values [default settings] Description

49 ESD error codes (display only)

F0 No test available No test available or test cancelled manually

F1 Test OK

F2 x cancellation Test cancelled by the x cancellation function

F3 y cancellation Test cancelled by the y cancellation function

F4 Tolerance band exceeded The test has been cancelled. x values outside the toler-
ance band occurred

F5 Max. test time exceeded Test not completed within the maximum test
duration and therefore cancelled

F6 Test manually cancelled Test cancelled by the operator

F7 Measured data storage out of
memory

Storage for measured values out of memory. After 100
measured values per measured variable, the logging is
stopped. However, the test is still continued.

F8 Aborted by solenoid valve Test cancelled by the solenoid valve being triggered

F9 Supply pressure/ friction Test cancelled due to insufficient supply pressure or
excessive friction



3 EXPERT+ test functions

By default, all positioners in ESD version in-
clude the EXPERT+ valve diagnostic func-
tions. However, the positioner’s operating
mode determines which diagnostic functions
are available.

Presetting actuator and valve data

To use the integrated EXPERT+ functions,
certain details on the actuator and valve
used need to be entered, including:

� Model parameter under [Identification >
Positioner > Actuator]
Options: single acting, double acting
Default: single acting

� Booster parameter under [Identification >
Positioner > Actuator]
Options: not present, present
Default: not present

� Stuffing box parameter under [Identifica-
tion > Positioner > Valve]
Options: self-adjusting, adjustable pack-
ing, bellows seal
Default: self-adjusting

If actuator and valve correspond to the de-
fault values, no further settings need to be
entered.
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EXPERT+ test functions

Operating mode
(Code 0)

EXPERT+ functions Test requirements

AUtO
As in EB 8388 EN

MAN

ESD mode

ESD Man Data logger/ Statistical
information Auto
TROVIS-VIEW 3: [Diag-
nosis > Statistical information
AUTO > Data logger]

For test description,
see EB 8388 EN, section 2.1
Note! The valve position is used as the valve
travel condition by the data logger of
positioners in ESD version.

Drive signal y Hysteresis/
Statistical information Auto
TROVIS-VIEW 3: [Diag-
nosis > Statistical information
AUTO > Drive signal dia-
gram > Hysteresis]

For test description and requirements, see
EB 8388 EN, section 2.5.2
Actuator and valve data need to be preset, see
above

ESD Auto Data logger/ Statistical
information Auto
TROVIS-VIEW 3: [Diag-
nosis > Statistical information
AUTO > Data logger]

For test description,
see EB 8388 EN, section 2.1
Note! The valve position is used as the valve
travel condition by the data logger of
positioners in ESD version.



4 Notes on applications

Usually, shut-off valves in a safety-instru-
mented system are equipped with a solenoid
valve for emergency shutdown.

Several setups are possible when integrating
the Type 3730-3 Positioner in ESD version
into the automation system:

In Fig. 3, the positioner replaces the sole-
noid valve.

The safety function is triggered by the
safety-related control; accordingly, the sole-
noid valve and the limit switch are con-
nected to it.

To read the additional diagnostic
information and define set points, it is advis-
able to integrate the positioner into the con-
trol system and the asset management sys-
tem.

As shown in Fig. 4, no solenoid valve is re-
quired since the positioner, similar to the so-
lenoid valve, is certified for safe shutdown.
When the energy supply fails, the pneumatic
output is safely vented.

In this setup, the positioner’s 4 to 20 mA
signal is applied to the safety-related pro-
grammable logic controller. The HART® pro-
tocol is used for connection to the asset
management system.

20 EB 8388-1 EN

Notes on applications

HART®
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Fig. 3 ·  Positioner replaces solenoid valve
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Fig. 4 · Positioner for emergency shutdown

Control system
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Fig. 5 shows a special application. In this
setup, the solenoid valve integrated into the
positioner (terminals 81, 82) is used to-
gether with an existing external solenoid
valve to trigger the data logger.
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ESD code 1732

24 V

4–20 mA
+
–

+81
–82
11
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HART®

Fig. 5 · Positioner with external solenoid valve

Supply air
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